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Document information

If you use this guide, please let us know at imadocs@centurylink.com. We
welcome your feedback on this document.

The versions of this guide for the new release are listed below:

Document date Description

March 6, 2017 Draft guide for CMP review posted at

[Draft] http://www.centurylink.com/wholesale/cmp/review.html
March 13, 2017 Final guide posted at

http://www.centurylink.com/wholesale/cmp/
review_archivesystem.html

April 3, 2017 Final guide posted at
http://www.centurylink.com/wholesale/ima/gui/index.html

You can find guides for prior releases at
http://www.centurylink.com/wholesale/cmp/review_archivesystem.html.

Change log

Changes to IMA for this release are provided through CMP (change
management process) at http://www.centurylink.com/wholesale/cmp/
index.html.

Change for this release:

e Section 2 - Software Requirements - Support IE 11 and support HTML5
compliant browsers

e Section 2 - Java Run Runtime Environment - Support Java 1.8

Copyright and Trademarks

©2001-2017 CenturylLink, Inc. All Rights Reserved. The CenturyLink mark,
pathways logo and certain CenturyLink product names are the property of
CenturylLink, Inc. All other marks are the property of their respective owners.
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Getting started

This guide provides
e basic information about Interconnect Mediated Access (IMA)
e software and hardware requirements
e instructions for
e configuring Internet Explorer
e modifying the java.policy file
e Internet access to IMA
This guide is intended for employees of the ISC (Interconnect Service Center),

IWSC (Interconnect West Service Center), the LOC (Listing Operation Center),
and Competitive Local Exchange Carriers (CLECs).

This guide assumes you have a background in telecommunications local
service.

IMA is available for use by CLECS in the legacy Qwest territories within the
former 14-state Qwest region.

CenturyLink SYADs

CLECs

April 3, 2017

CenturyLink™ system administrators create IMA accounts for all CLECs,
including establishing the first CLEC system administrator and maintaining
user profiles.

CLECs interact with IMA on two levels:

e administrators create and manage all CLEC user accounts
e users manage all service requests through IMA

http://www.centurylink.com/wholesale/ima/gui/index.html
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System security

IMA allows CLECs access to local service elements of the CenturyLink network
and electronic access to its legacy operations support systems (0OSS).

CLECs use IMA to create local service requests (LSRs) and submit them to
CenturyLink for processing. LSRs contain the information CenturyLink needs to
create service orders for the CLECs.

System security

IMA provides a secure environment for its users.

System security Description and access

Username and password IMA usernames and passwords for CLEC system
administrators are obtained from a CenturyLink system
administrator. CLEC system administrators must receive
these before they can access IMA.

CLEC system administrators give CLEC users their
username and password. To ensure security, new users
should change their individual password the first time they
log in to IMA. (See “Changing your password” on page 21.)

You can change your password at any time. (System
administrators can also reset passwords.)

User PIN and Corporate ID PINs and IDs are obtained from a CenturyLink Wholesale
Markets service manager. Only users who have these
credentials can enter the IMA secure environment and
access its data, preventing unauthorized persons from
gaining access to protected information.

IMA provides an additional level of security by letting the CLEC system
administrators decide the access rights users will need—administrator
privileges or user privileges. Access rights define specific privileges users have
to operate within IMA. If a user performs the tasks of both an administrator
and a user, this user requires two IMA usernames and passwords, one as a
user and one as an administrator.

An administrator can inactivate a user when necessary, preventing the user
from accessing IMA and data stored in any of the databases. For more
information on CLEC system administrative privileges, see the CLEC System
Administrator’s Guide (http://www.centurylink.com/wholesale/ima/gui/
index.html).

IMA hours (Mountain Time)

April 3, 2017

Monday-Friday 6 a.m. to midnight
Saturday 6 a.m.to9 p.m.
Sunday 10 a.m. to 7 p.m.

http://www.centurylink.com/wholesale/ima/gui/index.html
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Additional resources

Additional resources

Web sites

IMA Access

https://ima.centurylink.com/ima

Products and Services

http://www.centurylink.com/wholesale/pcat/index.html

CenturyLink E-Business—Digital Certificate Procedures

http://ecom.centurylink.com

Wholesale Customer Contacts business procedure

http://www.centurylink.com/wholesale/clecs/escalations.html

Wholesale Resources—IMA

http://www.centurylink.com/wholesale/ima/index.html

Documents

April 3, 2017

In addition to this document, CenturyLink provides four other guides to help
you use IMA.

The first three guides are available at
http://www.centurylink.com/wholesale/ima/gui/index.html

e CLEC System Administrator’s Guide—guidelines for managing CLEC users’
accounts

e Facility-Based Directory Listings Guide—guidelines for submitting orders
for facility-based directory listings

e [MA User’s Guide—guidelines for preparing, submitting, and following up
on LSRs

The fourth guide is available at
http://www.centurylink.com/wholesale/training/coursecatalog.html:

e Loop Qualification and Raw Loop Data CLEC Job Aid—guidelines for
retrieving raw loop data and for checking whether a loop qualifies (for
CenturyLink HSI/Broadband Service or for unbundled ADSL service)

http://www.centurylink.com/wholesale/ima/gui/index.html
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Requirements

This chapter describes hardware and software requirements for IMA. If non-
IMA applications are running concurrently with IMA, these requirements may
need to be increased.

Note: When a new version of IMA is installed, you must log out of IMA
and log back in to continue working.

Software requirements

Important: CenturylLink supports and certifies Windows 7 as the
operating system for IMA. CenturyLink recommends you to
use Internet Explorer 10.0/11.0 as your browser when
running Windows 7. IMA may function using different
browsers and Windows operating systems, however,
CenturyLink will not be responsible for any problems
encountered when using operating systems other than
Windows 7.

e Microsoft Windows 7
e Internet Explorer 10.0/11.0 (recommended)

e HTML5 compliant browsers such as Firefox, Safari, and Chrome have been
tested with the Java applet. These browsers will require plugins to support
Java applets - see https://java.com/en/download/help/
enable_browser.xml.

e Java Runtime Environment 1.7_u52 thru 1.8_u51 for Internet Explorer.
However, CenturyLink recommends that Internet Explorer users upgrade to
at least Java Runtime Environment 1.8.

Hardware requirements (minimum)

e 1 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor
e 1 gigabyte(GB) RAM (32-bit) or 2GB RAM (64-bit)
e 16 GB available hard disk space(32-bit) or 20 GB(64-bit)

April 3, 2017 7
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Java Desktop Runtime Environment for IMA
e DirectX 9 graphics device with WDDM 1.0 or higher driver
e LAN connection to CenturyLink

e 200 MB free disk space (after all software installation and Windows virtual
memory file allocation)

Additional memory (RAM) and a faster network connection and CPU may
improve performance of IMA.

Java Desktop Runtime Environment for IMA

IMA is certified for Java Runtime Environment (JRE) 1.8.0_51 (1.8 u51).
Please contact your desktop support if you need the Java RE for your
desktop.(Backward compatibility is provided for JRE 1.7.0_52 (1.7 u52).

The Java Desktop Runtime Environment (JRE) can be found at

http://java.com/en

If the Java Desktop JRE has not already been installed, a Java Runtime
Environment Not Installed popup window appears in IMA GUI. This appears
only when PreOrder/Order/PostOrder is launched for the first time and the
Java Desktop Runtime Environment has not been installed.

Note: It might be possible for an unsupported browser to run the
PreOrder/Order/PostOrder GUI after the Java Runtime
Environment has been installed. If you encounter problems,
however, CenturyLink first recommends that you install IE 10 or
IE 11 browser.

April 3, 2017 8
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Connecting to IMA

If you are accessing IMA over the Internet, several factors external to
CenturyLink (such as your Internet service provider—your ISP—and Internet
traffic) may impact response time.

If you're accessing IMA using a digital certificate, use this URL: https://
ima.centurylink.com/ima. (CenturyLink recommends that you bookmark this
URL.)

Logging in to IMA for the first time

April 3, 2017

The Interconnect Login window ensures that only authorized users access
IMA. To log in, you need your corporate ID, username, and password. (You can
get this information from your system administrator.)

See “System security” on page 5.

Interconnect Login

Interconnect
Mediated

Enter your Corporate ID, Username and Password then Click 'Login'.

Corporate ID:
Usemame:
Pascword:

Clear

1 In the Interconnect Login window, type your corporate ID, username,
and password. (These fields are case-sensitive.)

2 Click Login.

The first time you log in to IMA, your password is the same as your
username. As soon as you create your personal profile, you should change
your password. (See page 21.)

http://www.centurylink.com/wholesale/ima/gui/index.html
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Creating your personal profile

3—Connecting to IMA
Creating your personal profile

The first time you log in to IMA, you must fill in your personal profile before
you can go on to other tasks. Your personal profile contains information that

CenturyLink uses to contact you.

Tip: Administrators—you might want create a joint e-mail account and
phone number so that all users have access to this e-mail or phone
number in case of absence, emergency, or work flow. This group
e-mail and phone number can then be entered in the individual

user’s profile.

ﬂ’ Personal Profile - Windows Internet Explorer. E@E

@ > [& ] [+ x Pl
File Edt Yew Favarites Tooks Help

S¢ g fHeme - dmPrne - [-Page + ) Took - (@) Hel -

Personal Profile

Name:
Telephone Number:
E-Mail Address:
Fax:
Street Address:
Floor:
Room/Mail Stop:
City:

State: |AL v
Zip/Postal Code:

[ Update Database ] [ Logout ]

Either an Email address or valid Fax Number is required as part of the User Profile information.

& Local intranet

1 Fill in the fields. (Floor and Room/Mail Stop are optional.)

a For your telephone and fax numbers, use the format 555-555-5555.

b Fill in your e-mail address, fax number, or both to indicate how you

want to receive system notifications.

2 Click Update Database. (If you click Logout, your profile won’t be saved
and you’ll still need to create your personal profile next time you log in.)

3 Click Return to Main Menu.

The Interconnect Functions window appears. Depending on your access

level, you may see fewer options.

Interconnect Functions

System Administration
User Administration
Set CUID

PreOrder/Order/PostOrder

Status

Line Loss

Baich Hot Cut Status
Firm Order Manager
Lock Administration
Resource Return

SOV Recent Page Report
Yirtual CSR

View Reference Data

Logout

April 3, 2017
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3—Connecting to IMA
Modifying your personal profile

Important: Be sure to use buttons within IMA. Don’t use the browser’s
buttons (e.g., Back) or you may get an error.

Modifying your personal profile

After you have created and saved your personal profile, you can modify it

further as needed.

1 In the Interconnect Functions window, click User Administration.

G0 - b TOE Ak
Fle Edt Uew Favorkes [ools Help
o ot fGrHome - MhFgt - mhPage - £ Tools - @) Help ~

Name:

Telephone Number:
E-Mail Address:
Fax:

Street Address:
Floor:

Room/Mail Stop:
City:

State:

Zip/Postal Code:

Personal Profile

IMA Documentation
111-222-3333
imadocs@qwestcom
123-456-7890

930 15th Street

5

Denver
co v
80202

Update Database

Return to Main Menu

& Local intranet

H100% -

2 Click in each field to be modified, and change the information. (Remember
to use the format 555-555-5555 for the telephone and fax numbers.)

3 C(Click Update Database.

4 Click Return to Main Menu.

Changing your password

For security reasons, you should change your password often.

April 3, 2017
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Changing your password

1 In the Interconnect Functions window, click Set Password.

{2 Set Password - Windows Internet Explorer EHE\E

@' & v ([ % D~

Fle Edi View Favortes Took  Help

i ar  fGHome - d®Prnt - [ Page ~ i Tooks - (@) Help -

Set Password

Enter New Password.

Old Password:
New Password:

Re-Type New Password:

Return to Main Menu

2 Do the following:

In this field ... Type ...

Old Password Your current password

New Password Your new password (6-8 characters, at least one of which is

a number or special character)

Re-Type New Password

3 Click Set Password.
IMA changes your password.
4 Click Return to Main Menu.

April 3, 2017
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E-business Internet connection

CenturyLink E-business digital certificates (or digital IDs) are issued for each
of your employees. They are required for each personal computer used to
access CenturylLink systems via the Internet.

E-business digital certificate registration is a one-time process and must be
renewed every five years.

You must first request a digital certificate before starting the registration
process.

Requesting a digital certificate

April 3, 2017

The CenturyLink E-Commerce group obtains the VeriSign and legacy Qwest
cobranded digital certificates needed to access IMA via the Internet.

The digital certificate process is administered by the CenturyLink WSSA
(Wholesale Systems Security Administration) group. This group has
responsibility over these certificates for end users, including revocation of a
certificate and updating user information.

To request a digital certificate

1 Contact your CenturyLink service manager at:
http://www.centurylink.com/wholesale/clecs/accountmanagers.html

Note: You may also go to the Wholesale Systems Web site at
http://www.centurylink.com/wholesale/systems/
generalinfo.html for request information and forms.

2 Fill out the digital certificate request form.

3 E-mail the completed form to your CenturyLink service manager.

The CenturyLink service manager verifies that the information is complete
and correct and then forwards your request to WSSA. The WSSA sends
your information to ECOM to assign the certificate and PIN information.

Important: All digital certificate requests must go through a
CenturylLink service manager. Under no circumstances
should you e-mail your request directly to the CenturyLink
Wholesale Systems Security Administration group. Your
request will not be processed.

13
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Downloading your digital certificate

Once your request is processed, the information is updated in the LDAP server
and an e-mail reply is sent to you. Please allow a minimum of 48 hours to
process and update security databases.

The e-mail contains the following information you must have before registering
your digital certificate:

e digital certificate number
e PIN
e instructions for their use

Once you've registered your digital certificate, you must have the following
before you can access IMA:

e your company’s corporate ID
e username

e password

Downloading your digital certificate

To begin the downloading process

1 Go to the CenturyLink Online Service Center Web site at
(http://www.centurylinkapps.com/wholesale/cert/index.html).

ﬁ Centurylink | Wholesale - Windows Internet Explorer provided by Centurylink \Z||E\Pz|
@.\--- > |g, httpef feavan centurylinkapps . comfwholesale/certfindes. html V| | % | | L2~
File Edit Wew Favorites Tools  Help
3 P - n »
W e | @CenturyLink\ Wholesalz l | ﬁﬁ - B - ,;}" o
&
‘ - Login to Control Center | Contaci
il &
~ = CenturyLink
L « Search CenturyLink Whalesale
Wholesale
Residential | Small - Medium Busi | Large Busi
\Wholesale Products 8 Services Customer Senice Manage My Account i

Wholesale: Products & Services

Gt dll  Getting Started with a Digital Certificate

Digital Certificate FAQ What is the Online Service Center?
What Tools are Available?

Why Do | Need a Digital Certificate?
What if | have Questions?
How Much Does it Cost?

Will My Information Be Kept Private?

What is the Online Service Center?

Privacy Policy

The Online Sewice Center is a jumping-off point to various e-commerce web sites accessible to
custamers who have Dioital Certificates throuah CenturvLink. Throuah these secure web sites. b
s | b

Done @ EB e Internet H100% v

2 Select Begin Digital Certificate Download Process.

April 3, 2017 14
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4—E-business Internet connection

Downloading your digital certificate

Important: Digital certificates must be downloaded within 30 days of
receipt. Digital certificates not downloaded within this time
are removed from the system. If your digital certificate has
been removed, you must request a new one.

(E=8ER ==
)€ oo o comuink ol e g ol P - &6 %] @ contuytinkonesipcent. x| & s i)

File Edit View Favorites Tools Help

A\l
P
- =

¥

CenturyLink~
CenturyLink OneStep Certificate Enroliment/  ENEGEGcING

Step 1: Installing the Root CA Certificate.
If you have not already done so. you must install the Root CA Certificate in your browser. ff you
already have a Root CA Certificate in your browser, you may proceed to step

« Toinstallthe Root CA Certificate, click the button to the right- | Install Certificate

« On'the popup dialog, select at least Trust this CA to identify web sites and Trust this CA to
identify email users_

* Click OK

Step 2: Information for your Digital ID
The information that you enter here is used to create the public portion of your Digital 1D. Fill in all
fields.

User ID

PIN

Step 3: Cryptographic Service Provider
The options in the Cryptographic Senice Provider drop down box are based upon the configuration
of your machine. Choose one of the Microsoft options listed below. We encourage you to choose
the strongest encryption available which is either Microsoft Enchanced Cryptographic Provider v1.0
or Microsot Strong Cryptographic Provider v1.0

Cryptographic Service Provider

Key Size 1024 = -

H100% v

3 Fill in the User ID and PIN fields and click Accept.

Note: The client certificate is a personal certificate that identifies an
individual CLEC user via a 9 character ID stored in their
CenturylLink /Legacy Qwest issued client Public / Private Keys.
This client certificate is requested via CenturyLink / Legacy
Qwest form and the certificate key Pair is downloaded into the
browser on your local machine to encrypt data that is
transmitted from you, the CLEC user to CenturyLink. (Note:
These certificates are still being issued by the Qwest certification
authority (CA)).

This certificate is stored only on the workstation and
browser for that you downloaded it into. Multiple users’
client certificates may be stored on a single workstation.
However, if another workstation or a different browser version is
to be used by the same user, then either the Public / Private Key
pair must be re-downloaded to the new browser version /
workstation or the certificate must be exported from the existing
location and imported into the new browser/workstation. For
this, you must use the Windows certificate export tools and
export the client certificate (look for the 9 character user ID) to a
USB drive/CD and then on the new workstation/browser use
certificate import tools to download the same files from the USB
Drive/CD.

http://www.centurylink.com/wholesale/ima/gui/index.html
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Verifying the installed certificate

4 Click Yes if you receive an ActiveX Control warning.

Patential Scripting Violation

This Wb site s sdding ons or more catficates to this computer, Allosing an untneted Wish dhe bo upsdste your
cartificates i a securky risk. The Web che could inctall certificates you do not krust, which could sllow programs that
ks & Pk bruist b run o s compater and gain acorss bo pour data,

Do you want Hhes program to add the certificates now? Clck Yes I you trust this Wb ste. Otherwiss, dick ho.

= = |

5 Click Yes at the security warning to proceed with installation.

'} You are about o install a certificate from a certification authority (CA) claiming to represent:
- Quiest Communications International Inc Roat CA v1

Windows cannot validate that the certificate is actually from "Qwest Communications International Inc Root CA v1",
R R 2

Y contacting "Cuwest Inc Root CA v1". The following
number will assist you in this process:

Thumbprint (shal): CCECSBIE FOAZBEIC 4ASEBISE 27D256C 1 BSGAAAIE

Warning:
IF you instal this root certificate, Windows will automatically trust any certificate issued by this CA. Instaling a
an rmed thumbprink is a y risk. IF you click "Yes” this risk,

Do you want to instal this certificate?

o

When the client digital certificate is fully loaded on the workstation, the
registration process is complete.

& st coonryi. oot bedoresies ~[@]4lx
Be B gew Fpeis s tes
G S| cars tatoon a-a

I
CenturyLink OneStep Certificate Enroliment | N EREN

Enroliment Complete

Congratulations!

Your certificate has been generated
Depending on the version of Windows you
are using, you may recesve an ActiveX
‘Conrol viarming, Select Yes for the Actve)(
Control waming

Select e’ for Do you want s program o
‘add the certficate now?

Your certificate has been downloaded and installed into your Web browser.

CerturyLink

Verifying the installed certificate

1 Choose Tools > Internet Options in your Internet Explorer browser.

=)o)
m\@mp: e cemyricom oL - 8.6 X | @ Carbinkoneig Cat || o 1r 6

File Edit View Favortes |RCig| Help

Deletebrowsing history. CtrShift-Cel -
Inprivate Browsing Gt Shift+P RIS
Activex Filtering CenturyLink*~

v top Certificate Enrollment
ling the Root CA Certificate.

View cownloads Cti-J|alieady done 0, you must install the Root CA Certiicate in your browser. If you
Pop-up Blocker , |Root CA Certficate in your browser, you may proceed to step 2.
SmartScreen Fiter » =
i il the Root CA Certiicate, click the button to the right: [ Install Ceificate
opup dialcg, select at least Trust this CA to identify web sites and Tust this CA to
Compatibilty View email users

Compatibilty View settings

Subsciibe to this feed.

Feed ciscovery > hation for your Digital ID

Windews Updaze that you enter hers is used to create the public poriion of your Digital ID. Fillin all

F12 developer tools User ID 747985640 I

Internet options

PIN

Step 3: Cryptographic Service Provider

“he opticns in the Cryptographic Senvice Provider drop down box are based upon the configuration
of your machine. Choose ane of the Microsoft options listed below. We encourage you to choose
the strongest encryption available which ic either Microsoft Enchanzed Cryptographic Providzr v1.0
or Microsoft Strong Cryptographic Provider v1.0

Cryptographic Service Provider

Key Size 1024 ~

Erables you to change setfings.

#100% v

April 3, 2017 16
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2 On the Content tab, choose Certificates.

Internet Options

| General [ security | Privacy | Content | connections | Programs | Advanced |

Content Advisor

?ﬁ Ratings help you control the Internet content that can be
wviewed on this computer.

Certificates
Use certificates for encrypted connections and identification,
[ cClearssistate || certficates ] [ Fublishers |
AutoComplete

= AutoComplete stores previous entries

on webpages and suggests matches
for you.

Feeds and Web Slices

E Feeds and Web Slces provide updated
5

content from websites that can be
read in Internet Explorer and other
programs.

@ Some settings are managed by your system administrator.

Double click on the certificate’s name.

Certificates

Intended purpose: [<AII>

Personal |Oﬂwar People | Intermediate Certification Autharities | Trusted Root Certification * | *

Issued Ta Issued By Expiratio... ~ Friendly Name

E= Qwest Communi

Import... ][ Export... ][ Remove

Certificate intended purposes

<All=

Learn more about certificates

http://www.centurylink.com/wholesale/ima/gui/index.html
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Verifying the installed certificate
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Modifying the java.policy file

4 View the General tab.
Certificate @

Gereral |petails [ certification Path

£33 Certificate Information

This certificate cannot be verified up to a trusted
certification authority.

Issued to: Qwest Communications International Inc

Issued by: ECOM User CA

valid from S/ 12/ 2011 to 2/ 11/ 2016

=

You have a private key that corresponds to this certificate.

Learn more about certificates

5 View the Certification Path tab.

Certificate @
General I Detailg | Certification Path |

Certification path

WJ Qwest Communications International Inc Root CA w1
-{Z5] ECOM User CA

MG, <<t Commncations Interatonalinc|

Certificate status:

’This certificate is OK.

Learn more about certification paths

Modifying the java.policy file

Important: CenturylLink highly recommends that you create a backup
copy of the java.policy file.

1 Using Windows Explorer, access the java.policy file from the folder
C:\ProgramFiles(x86)\Java\jrel.7.0_51\lib\security for a 32 bit Internet
explorer or C:\ProgramFiles\Java\jrel.6.0_xx\lib\security for a 64 bit
Internet Explorer

2 Select the java.policy file.

April 3, 2017 18
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3 Select Edit > Copy, then select Edit > Paste.
A copy of the java.policy file appears in this same folder.

T
@U" » Computer  OSDisk (C » Program Files  Java » jklT0SL b jre b lib » security
Organize v [ | Open Newfolder

3 Favorites
I Desktop
8 Downloads

] Recent Places
B Desktop )
] RecentPlaces ()

8 Dovnloads ()

2 Libraries
[ Documents
@ Music
(=] Pictures

BB videos
% Computer

€ Network

java,policy Date modified: 6/10/2014 4:23 PM Date created: 6/10/2014 4:23 PM
POLICY File Size: 253 KB

blackiist cacerts Jove.policy fevesecurty  javafxpolicy

javaws.policy

&)

[ 43 |[ seorchsecury

&

local_policy  trustedlbraries  US_export.policy

-

Ukl W gl < nfed
\ji" Fau— i K0 REE I ,I" _I # al
: ) 4

Cogn
ot B0 oiad ,-'-*- T EL N B - T

Gy V4 abe

pammlssion ava
Sura. speai fioation, nane"

4 Using WordPad, open the java.policy file.

g

o

auct

rLyfermLpsion

PesghEnfRemmlealan

"java.vE, A"

parmiasion ava,lang, BustisaPermission "sstPaotory”i|

10 =

5 Edit the java.policy file by adding the following 3 lines:

o e

e permission java.util.PropertyPermission "javax.net.ssl.*", "read,write";
e permission java.util.PropertyPermission "user.home", "read";
e permission java.lang.RuntimePermission "setFactory";

Insert these lines at the bottom of the file just above the }; symbol.

http://www.centurylink.com/wholesale/ima/gui/index.html
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Tip: If you're reading these guidelines in Adobe Acrobat, you can use
the Select Text tool to select the lines of text, copy them, and
paste them into the java.policy file. Copy and paste one line of text

at a time eliminating the leading bullet.
6 Save and close the java.policy file.

If you are unable to access the IMA PreOrder/Order/PostOrder functions after

completing the above procedure, do one of the following:

If you do not receive an error message, close all active windows and

programs and restart your computer.

If one of the following error messages displays, follow the instructions and

try accessing IMA PreOrder/Order/PostOrder again:

rresage

(R) ot Acess Prbhen. A potlem cccurod i Sysiem o,
<

0 k. Th secton d
satst agproimatey pago .

il

If this error message displays, check the java.policy file and make sure the 3
new additional lines you entered are accurate and placed correctly.

Error

Messages:

There is an error in the certificate password you entered or

Please see the instructions in the Manual.

<

0K Print Preview E-mail

in the name of the

certificate. ~

[

‘Ja\ta Applet \Window

If this error message displays, check to make sure the certificate password
and name are correct. The password is one you previously entered for the
certificate or qwestl1. The certificate name in your UserID folder must be

QwestIMACertificate.p12.

Note: For digital certificate assistance, call the CenturyLink Wholesale
Systems Help Desk (888-796-9102, option 2).

Importing your digital certificate to Internet

Explorer

This section is for current and new Internet Explorer users and explains how to

“move” your digital certificate.

All requirements for modifying the java.policy file must be completed before

continuing.

1 Open Internet Explorer.

April 3, 2017
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2 From the Tools menu, select Internet Options.
3 Click the Content tab.
Internet Opticns @

| General I Security I Privacy | Content | Connections I Programs I Advancedl

Content Advisor

Ratings help you control the Internet content that can be
wiewed on this computer.

nable...

Certificates

Use certificates for encrypted connections and identification.

[ Clear 351 state ] [ Certificates ] [ Publishers ]

AutoComplete

AutoComplete stores previous entries

% on webpages and suggests matches
for you.

Feeds and Web Slices
Feeds and Web Slices provide updated
Fal content from websites that can be
read in Internet Explorer and other
programes,

@l Some gettings are managed by your system administrator,

4 Click Certificates.
Certificates @

Intended purpose: [<AII> v]

Personal ‘Olﬁer Pegple |Ir diate Certification Authorities | Trusted Root Certificatior| ¢ | *

Issued To Tssued By Expiratio...  Friendly Name
[/ Quiest Commuricati... ECOM User CA 5/11/2015  <Mores

Certificate intended purposes

Learn more about certficates
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5 Click Import to activate the Certificate Wizard.
Certificate Export Wizard @1

Welcome to the Certificate Export
Wizard

This wizard helps you copy certificates, certificate trust
lists and certificate revocation lists from a certificate
store to your disk.

A certificate, which is issued by a certification autharity, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections, A certificate store is the system area where
certificates are kept.

To continue, dick Mext.

6 Click Next.

Certificate Import Wizard @

File to Import
Specify the file you want to import.

Eile name:
‘ Browse...

Note: More than one certificate can be stored in a single file in the following formats:

Personal Information Exchange- PKCS #12 (.PFX,.P12)
Cryptographic Message Syntax Standard- PKCS =7 Certificates (.P7B)

Microsoft Serialized Certificate Store (\55T)

Learn more about certificate file formats

{ < Back ] Dext > l Cancel I

7 Type the URL or select Browse to locate your certificate. Your certificate
should be located at C:\Documents and Settings under your specific
UserID and the file name of the certificate should be
QwestIMACertificate.p12.
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8 Click Next.

Certificate Import Wizard @

Password

To maintain security, the private key was protected with a password.

Type the password for the private key.

Password:

[ Enable strong private key protection. You will be prompted every time the
private key iz used by an application if you enable this optian.

[ Mark this key as expartable. This will sllow you to back up or franspart your
keys at a later time.

[#] Include all extended properties.

Learn more about protecting private keys

< Back ][ [ext = ][ Cancel

9 In the Password field, type qwestl. This password is case-sensitive.
10 Click Next.

Certificate Import Wizard @

Certificate Store
Certificate stores are system areas where certificates are kept,

Windaws can automatically select a certificate stare, or you can specify a location for
the certificate.

(7) Automatically select the certificate store based on the type of certificate

@ Place all certificates in the fallowing sto

Certificate store:
Personal

Learn more about certificate stores

< Back “ Next » l[ Cancel
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11 Leave the settings at their default positions and click Next.

‘fou have spedfied the following settings:

Content PFX
File Mame

Certificate Import Wizard
Completing the Certificate Import
Wizard
L The certificate will be imported after you dick Finish,

Certificate Store Selected by User [EEEE]

Cr\Users\ 400724\ Des

B

< Back ][ Finish

] [ Cancel

12 Click Finish.

Certificates

(sl

Intended purpose: [ <All=

7)

Personal | Other People | Intermediate Certification Authorities | Trusted Root Certification * | *

Expiratio...
9/11/2016

Issued To Issued By

Friendly Name

<None >

Impart... H Export... H Remove

Certificate intended purposes
<All=

Learn more about certificates

The name of the certificate appears in the Certificates list box along with

a confirmation message.

13 Click OK and close all active windows.

http://www.centurylink.com/wholesale/ima/gui/index.html
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